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Abstract—These instructions give you guidelines for prepang
papers for IEEE TRANSACTIONS and JOURNALS. Use this
document as a template if you are using MicrosoftWord 6.0 or
later. Otherwise, use this document as an instruain set. The
electronic file of your paper will be formatted further at IEEE.
Define all symbols used in the abstract. Do not @treferences in
the abstract. Do not delete the blank line immedialy above the
abstract; it sets the footnote at the bottom of ts column.

Index Terms—About four key words or phrases in alphabetical
order, separated by commas. For a list of suggestdeywords,
send a blank e-mail to keywords@ieee.org or Vvisit
http://www.ieee.org/organizations/pubs/ani_proditelf8.txt

I. INTRODUCTION

HIS document is a template for Microsdford versions

6.0 or later. If you are reading a paper or PDFsieer of
this document, please download the electronic
TRANS-JOUR.DOC, from the IEEE Web site
http://www.ieee.org/web/publications/authors/trafigidex.html so
you can use it to prepare your manuscript. If yawb prefer

to use LATEX, download IEEE’s LATEX style and sampl

files from the same Web page. Use these LATEX fitas
formatting, but please follow the instructions IrRANS-
JOUR.DOC or TRANS-JOUR.PDF.

If your paper is intended for eonference, please contact

your conference editor concerning acceptable woodgssor
formats for your particular conference.

When you open TRANS-JOUR.DOC, select “Page Layou

from the “View” menu in the menu bar (View | Pagaybut),

Manuscript received October 9, 2001. (Write theedah which you

submitted your paper for review.) This work wassuped in part by the U.S.

Department of Commerce under Grant BS123456 (spoasd financial
support acknowledgment goes here). Paper titlesuldhbe written in
uppercase and lowercase letters, not all uppercaseid writing long

formulas with subscripts in the title; short formsilthat identify the elements

are fine (e.g., "Nd—Fe—B"). Do not write “(Invitédh the title. Full names of

at

which allows you to see the footnotes. Then, tyyer gections

of TRANS-JOUR.DOC or cut and paste from another

document and use markup styles. The pull-down siygau is
at the left of the Formatting Toolbar at the topyofir Word

window (for example, the style at this point in thecument is
“Text"). Highlight a section that you want to desie with a
certain style, then select the appropriate namehenstyle
menu. The style will adjust your fonts and lineapg. Do not

change the font sizes or line spacing to squeeze nadext

into a limited number of pages.Use italics for emphasis; do
not underline.

To insert images inWord, position the cursor at the
insertion point and either use Insert | Picturegnt File or
copy the image to the Windows clipboard and thei [Hiaste
Special | Picture (with “float over text” unchecked

IEEE will do the final formatting of your paper. Yfour

fidoaper is intended for a conference, please obsémee

conference page limits.

Il. PROCEDURE FORPAPER SUBMISSION

A. Review Sage

Please check with your editor on whether to subyiir
manuscript as hard copy or electronically for rewvi¢f hard
copy, submit photocopies such that only one colappears
per page. This will give your referees plenty aobmroto write
gcomments. Send the number of copies specified by gditor

[(typically four). If submitted electronically, findut if your

editor prefers submissions on disk or as e-maitchtnents.
If you want to submit your file with one column
electronically, please do the following:
--First, click on the View menu and choose Priayaut.
--Second, place your cursor in the first paragrdpb to

the Format menu, choose Columns, choose one column

Layout, and choose “apply to whole document” frohe t

authors are preferred in the author field, but moe required. Put a space dropdown menu.

between authors’ initials.

--Third, click and drag the right margin bar taetwver 4

F. A. Author is with the National Institute of Stéards and Technology, inches in width

Boulder, CO 80305 USA (corresponding author to ewphone: 303-555-
5555; fax: 303-555-5555; e-mail: author@ bouldst.gbv).

S. B. Author, Jr., was with Rice University, Houst@X 77005 USA. He
is now with the Department of Physics, ColoradoteStdniversity, Fort
Collins, CO 80523 USA (e-mail: author@lamar.coltsgidu).

T. C. Author is with the Electrical Engineering Refment, University of
Colorado, Boulder, CO 80309 USA, on leave from Mational Research
Institute for Metals, Tsukuba, Japan (e-mail: au@orim.go.jp).

The graphics will stay in the “second” column, lyati can
drag them to the first column. Make the graphicesitb push
out any text that may try to fill in next to theaghic.

B. Final Sage

When you submit your final version (after your papas



been accepted), print it in two-column format, utihg

figures and tables. You must also send your finahuscript
on a disk, via e-mail, or through a Web manusaiftmission
system as directed by the society contact. You ns@&Zip or

CD-ROM disks for large files, or compress files ngsi
Compress, Pkzp, Suffit, or Gzp.

Also, send a sheet of paper or PDF with completegac
information for all authors. Include full mailingddresses,
telephone numbers, fax numbers, and e-mail addre3ses
information will be used to send each author a dongmtary
copy of the journal in which the paper appearsadidlition,
designate one author as the “corresponding autfibis’is the
author to whom proofs of the paper will be senbdfs are
sent to the corresponding author only.

C. Figures

picas wide). We recommend that you avoid sizingrég less
than one column wide, as extreme enlargements risagrid
your images and result in poor reproduction. Thaeefit is
better if the image is slightly larger, as a mimeduction in
size should not have an adverse affect the qu#litlye image.

Sze of Author Photographs

The final printed size of an author photograph xaodly
1 inch wide by 1 1/4 inches long (6 picas x 7 litag). Please
ensure that the author photographs you submit
proportioned similarly. If the author's photograploes not
appear at the end of the paper, then please siethtat it is
proportional to the standard size of 1 9/16 inchéde by
2 inches long (9 1/2 picas x 12 picas). JPEG fies only
accepted for author photos.

are

Format and save your graphic images using a seitaliiow to create a PostScript File

graphics processing program that will allow yowcteate the
images as PostScript (PS), Encapsulated PostSEMS), or
Tagged Image File Format (TIFF), sizes them, arnjdstslthe
resolution settings. If you created your sourcesfiln one of
the following you will be able to submit the graghiwithout
converting to a PS, EPS, or TIFF file: Microsoft Wp
Microsoft PowerPoint, Microsoft Excel, or Portalilecument
Format (PDF).

D. Electronic Image Files (Optional)

Import your source files in one of the following:idvbsoft
Word, Microsoft PowerPoint, Microsoft Excel, or Rable
Document Format (PDF); you will be able to subntie t
graphics without converting to a PS, EPS, or Tlidsf Image
quality is very important to how yours graphicslwéproduce.
Even though we can accept graphics in many formass,
cannot improve your graphics if they are poor dualihen we
receive them. If your graphic looks low in qualityn your
printer or monitor, please keep in mind that caningirove
the quality after submission.

If you are importing your graphics into this Woehtplate,
please use the following steps:

Under the option EDIT select PASTE SPECIAL. A d@lo
box will open, select paste picture, then click t¢ur figure
should now be in the Word Document.

If you are preparing images in TIFF, EPS, or PSnfur
note the following. High-contrast line figures aadbles should
be prepared with 600 dpi resolution and saved with
compression, 1 bit per pixel (monochrome), witk filames in
the form of “fig3.tif" or “tablel.tif.”

Photographs and grayscale figures should be prépeth
300 dpi resolution and saved with no compressiobits8 per
pixel (grayscale).

Szng of Graphics
Most charts graphs and tables are one column vdeZq
inches or 21 picas) or two-column width (7 1/16hies, 43

First, download a PostScript printer driver from
http://www.adobe.com/support/downloads/pdrvwin.htrfor
Windows) or fromhttp://www.adobe.com/support/downloads/
pdrvmac.htm (for Macintosh) and install the “Generic
PostScript Printer” definition. IWord, paste your figure into a
new document. Print to a file using the PostScpphter
driver. File names should be of the form “fig5.pgl$e Open
Type fonts when creating your figures, if possil#idisting of
the acceptable fonts are as follows: Open Type $=dritnes
Roman, Helvetica, Helvetica Narrow, Courier, Symbol
Palatino, Avant Garde, Bookman, Zapf Chancery, Zapf
Dingbats, and New Century Schoolbook.

Print Color Graphics Requirements

IEEE accepts color graphics in the following formaEPS,
PS, TIFF, Word, PowerPoint, Excel, and PDF. Theltg®n
of a RGB color TIFF file should be 400 dpi.

When sending color graphics, please supply a higtity
hard copy or PDF proof of each image. If we caraubtieve a
satisfactory color match using the electronic \@rsdf your
files, we will have your hard copy scanned. Anytlod files
types you provide will be converted to RGB colorEfHes.

Web Color Graphics

IEEE accepts color graphics in the following formaEPS,
PS, TIFF, Word, PowerPoint, Excel, and PDF. Theltg®n
of a RGB color TIFF file should be at least 400. dpi

Your color graphic will be converted to grayscaleno
separate grayscale file is provided. If a grapbitoiappear in
print as black and white, it should be saved armirétted as a
black and white file. If a graphic is to appearpirint or on
IEEE Xplore in color, it should be submitted as RGior.

Graphics Checker Tool

The IEEE Graphics Checker Tool enables users takche
graphic files. The tool will check journal artictgaphic files
against a set of rules for compliance with IEEEuisgments.
These requirements are designed to ensure suffigieage
quality so they will look acceptable in print. Aftreceiving a
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Fig. 1. Magnetization as a function of applieddieNote that “Fig.” is

abbreviated. There is a period after the figure lemnfollowed by tw
spaces. It is good practice to explain the sigaifee of the figure in ti
caption.

graphic or a set of graphics, the tool will chelok files against
a set of rules. A report will then be e-maileditig each
graphic and whether it met or failed to meet trguiements.
If the file fails, a description of why and insttions on how to
correct the problem will be sent. The IEEE Grapl@tecker
Tool is available ahttp://graphicsqc.ieee.org/

For more Information, contact the IEEE Graphics #-B
Desk by e-mail afjiraphics@ieee.orgrou will then receive an
e-mail response and sometimes a request for a sagrggbhic
for us to check.

E. Copyright Form

TABLE |
UNITS FORMAGNETIC PROPERTIES

Conversion from Gaussian and

Symbol Quantity CGS EMU to SP
® magnetic flux 1Mx - 108Wb=108V-s
B magnetic flux density, 1 G- 10*T = 10* Wb/n?
magnetic induction
H magnetic field strength 1 Oe - 10%(4m) A/m
m magnetic moment lerg/lG=1emu
- 103 A-n?=10°% /T
M magnetization 1 erg/(G- éye 1 emu/cr
- 10° A/m
41iM magnetization 1G - 10%/(4m) A/m
o specific magnetization 1 erg/(G-g) = 1 emu/g 1 A-nf/kg
i magnetic dipole lerg/G=1emu
moment o 4nx 10°Wb-m
J magnetic polarization 1 erg/(G-&w 1 emu/cm
- 4x 10°%T
X, K susceptibility 1 4n
Xo mass susceptibility 1 cnvlg - 4mx 10° m¥kg
permeability 1 - 4rtx 107 H/m
= 41x 107 Wb/(A-m)
Hr relative permeability - pr
w, W energy density 1 erglen - 107 Jin?
N, D demagnetizing factor 1 - 1/(4m)

Vertical lines are optional in tables. Statemehtt serve as captions for
the entire table do not need footnote letters.

®Gaussian units are the same as cgs emu for matatees Mx =
maxwell, G = gauss, Oe = oersted; Wb = weber, \blt, ¢ = second, T =
tesla, m = meter, A = ampere, J = joule, kg = kidmg, H = henry.

dimensionally. If you must use mixed units, cleastate the
units for each quantity in an equation.

The SI unit for magnetic field strengkhis A/m. However,
if you wish to use units of T, either refer to matia flux
densityB or magnetic field strength symbolized agiuUse
the center dot to separate compound units, e.gnfA

An |EEE copyright form should accompany your final

submission. You can get a .pdf, .html, or .doc ieersat

http://www.ieee.org/copyright Authors are responsible for

obtaining any security clearances.

. MATH

V. HELPFULHINTS

A. Figuresand Tables

Because IEEE will do the final formatting of youaper,
you do not need to position figures and tableshattop and
bottom of each column. In fact, all figures, figuwagptions, and

If you are usingWord, use either the Microsoft Equationspies can be at the end of the paper. Large figanel tables

Editor or theMathType add-on (http://www.mathtype.com) for

equations in your paper (Insert | Object | CreatwN
Microsoft Equationor MathType Equation). “Float over text”
shouldnot be selected.

IV. UNITS

Use either SI (MKS) or CGS as primary units. (Siksiare
strongly encouraged.) English units may be useskasndary
units (in parenthesesphis applies to papers in data storage.
For example, write “15 Gb/ch{100 Gb/if).” An exception is
when English units are used as identifiers in tragleh as
“3Y-in disk drive.” Avoid combining S| and CGS uwitsuch
as current in amperes and magnetic field in oesstddhis
often leads to confusion because equations do alznbe

may span both columns. Place figure captions beflogy
figures; place table titles above the tables. Ilryfigure has
two parts, include the labels “(a)” and “(b)” asripaf the
artwork. Please verify that the figures and talyl@s mention
in the text actually existP’lease do not include captions as
part of the figures. Do not put captions in “text loxes”
linked to the figures. Do not put borders around tte
outside of your figures.Use the abbreviation “Fig.” even at
the beginning of a sentence. Do not abbreviate [&labables
are numbered with Roman numerals.

Color printing of figures is available, but is kil to the
authors. Include a note with your final paper iadiieg that
you request and will pay for color printing. Do ngte color
unless it is necessary for the proper interpratatid your
figures. If you want reprints of your color articlédne reprint



order should be submitted promptly. There is anitimofl

charge for color reprintsPlease note that many IEEE
journals now allow an author to publish color figures on
Xplore and black and white figures in print. Contad your

society representative for specific requirements.

Figure axis labels are often a source of confusidse
words rather than symbols. As an example, writegtientity
“Magnetization,” or “MagnetizationM,” not just ‘M.” Put
units in parentheses. Do not label axes only wititsu As in

used in the text, even after they have already le¢ined in
the abstract. Abbreviations such as IEEE, Sl, ad,dt do not
have to be defined. Abbreviations that incorporpégiods
should not have spaces: write “C.N.R.S.,” not “CRNS.” Do
not use abbreviations in the title unless theywaravoidable
(for example, “IEEE” in the title of this article).

D. Equations
Number equations consecutively with equation nusier

Fig. 1, for example, write “Magnetization (A/m)’ or parentheses flush with the right margin, as in Eljst use the

“Magnetization (Am™),” not just “A/m.” Do not label axes
with a ratio of quantities and units. For examplerite
“Temperature (K),” not “Temperature/K.”

Multipliers can be especially confusing.
“Magnetization (kA/m)” or “Magnetization (fOA/m).” Do

not write “Magnetization (A/mx 1000” because the reader

would not know whether the top axis label in Figmgant
16000 A/m or 0.016 A/m. Figure labels should beibdkgy
approximately 8 to 12 point type.

B. References

Number citations consecutively in square brack&lsThe
sentence punctuation follows the brackets [2]. Mldt
references [2], [3] are each numbered with sepdredekets
[1]-[3]. When citing a section in a book, pleaseegithe
relevant page numbers [2]. In sentences, referIgitgpthe
reference number, as in [3]. Do not use “Ref. [3Jf
“reference [3]" except at the beginning of a seogen
“Reference [3] shows ... .” Please do not use aatiom

equation editor to create the equation. Then sethet
“Equation” markup style. Press the tab key and ewthe
equation number in parentheses. To make your egsathore

Writeompact, you may use the solidus ( /), the exgtfan, or

appropriate exponents. Use parentheses to avoiaitids in
denominators. Punctuate equations when they are gbaa
sentence, as in

[ FG.g)drdg=[or,2u)]

0, exp(=112, -7 A" 3,(A1,) I(Ar)dA.

)

Be sure that the symbols in your equation have beéned
before the equation appears or immediately follgwitalicize
symbols T might refer to temperature, but T is the unitagsl
Refer to “(1),” not “Eq. (1)” or “equation (1),” @ept at the
beginning of a sentence: “Equation (1) is ... ."

E. Other Recommendations

endnotes inNord, rather, type the reference list at the end of ;qe gne space after periods and colons. Hyphenatplex

the paper using the “References” style.

Number footnotes separately in superscripts (Indert

modifiers: “zero-field-cooled magnetization.” Avoihngling
participles, such as, “Using (1), the potential wakulated.”

Footnote): Place the actual footnote at the bottom of thﬁt is not clear who or what used (1).] Write irete “The

column in which it is cited; do not put footnotes the
reference list (endnotes). Use letters for tabletrfotes (see
Table 1).

Please note that the references at the end ofitligment
are in the preferred referencing style. Give athats’ names;

do not use ét al.” unless there are six authors or more. Use ,% " o

space after authors’ initials. Papers that have beén

published should be cited as “unpublished” [4]. &apthat

have been accepted for publication, but not yetifipd for an

issue should be cited as “to be published” [5].d?aphat have
been submitted for publication should be cited sibmitted

for publication” [6]. Please give affiliations amdidresses for
private communications [7].

Capitalize only the first word in a paper title,cept for
proper nouns and element symbols. For papers peblign
translation journals, please give the English idtatfirst,
followed by the original foreign-language citatif@j.

C. Abbreviations and Acronyms
Define abbreviations and acronyms the first timeytlare

LIt is recommended that footnotes be avoided (exterthe unnumbered

potential was calculated by using (1),” or “Using),(we
calculated the potential.”

Use a zero before decimal points: “0.25,” not “’28se
“cm®” not “cc.” Indicate sample dimensions as “0.1 &.2
cm,” not “0.1x 0.2 cni.” The abbreviation for “seconds” is
t “sec.” Do not mix complete spellings and
abbreviations of units: use “Wbfmor “webers per square
meter,” not “webers/f” When expressing a range of values,
write “7 to 9” or “7-9,” not “7~9.”

A parenthetical statement at the end of a sentésce
punctuated outside of the closing parenthesis (iks). (A
parenthetical sentence is punctuated within thergheses.) In
American English, periods and commas are withintafien
marks, like “this period.” Other punctuation is fteigde”!
Avoid contractions; for example, write “do not” tead of
“don’t.” The serial comma is preferred: “A, B, af instead
of “A, Band C.”

If you wish, you may write in the first person sitgy or
plural and use the active voice (“I observed thator “We
observed that ...” instead of “It was observed thay.
Remember to check spelling. If your native languag@ot

footnote with the receipt date on the first padestead, try to integrate the English, please get a native English-speaking aglle to

footnote information into the text.



carefully proofread your paper. At least two reviews are required for every papdmsitted.
For conference-related papers, the decision topharereject
VI. SoME COMMON MISTAKES a paper is made by the conference editors and qgatiolnhs

The word “data” is plural, not singular. The suliscfor the committee; the recommendations of the refereesadvésory
permeability of vacuum qiis zero, not a lowercase letter “0.” Only. Undecipherable English is a valid reason rigection.
The term for residual magnetization is “remanenciie Authors of rejected papers may revise and resutirein to
adjective is “remanent’; do not write ‘“remnance” orthe TRANSACTIONS as regular papers, whereupon they will be
“remnant.” Use the word “micrometer” instead of tmon.” A reviewed by two new referees.
graph within a graph is an “inset,” not an “insefthe word
“alternatively” is preferred to the word “alternbfe (unless
you really mean something that alternates). Use wibed VIII. PUBLICATION PRINCIPLES
“whereas” instead of “while” (unless you are reifiegr to The contents of IEEE RANSACTIONS and dDURNALS are
simultaneous events). Do not use the word “esdbfitio  peer-reviewed and archival. TheRANSACTIONS publishes
mean “approximately” or “effectively.” Do not usbet word scholarly articles of archival value as well asotial
“issue” as a euphemism for “problem.” When compos& expositions and critical reviews of classical sotjeand topics
are not specified, separate chemical symbols byashes; for of current interest.
example, “NiMn” indicates the intermetallic compaun Authors should consider the following points:

NigsMngs whereas “Ni-Mn” indicates an alloy of somel) Technical papers submitted for publication mustaade

composition NiMny . the state of knowledge and must cite relevant pviark.

Be aware of the different meanings of the homophon®) The length of a submitted paper should be commatesur
“affect” (usually a verb) and “effect” (usually aoun), with the importance, or appropriate to the compiexaf
“complement” and “compliment,” “discreet” and “diste,” the work. For example, an obvious extension of
“principal” (e.g., “principal investigator”) and fmciple” previously published work might not be approprifde
(e.g., “principle of measurement”). Do not confusmaply” publication or might be adequately treated in jasew
and “infer.” pages.

Prefixes such as “non,” “sub,” “micro,” “multi,” @ah“ultra” 3) Authors must convince both peer reviewers and the
are not independent words; they should be joineti¢ovords editors of the scientific and technical merit gbaper; the
they modify, usually without a hyphen. There ispsoiod after standards of proof are higher when extraordinary or
the “et” in the Latin abbreviatioret al.” (it is also italicized). unexpected results are reported.

The abbreviation “i.e.,” means “that is,” and tHebeeviation 4) Because replication is required for scientific pess,
“e.g.,” means “for example” (these abbreviation® arot papers submitted for publication must provide sigfit
italicized). information to allow readers to perform similar

An excellent style manual and source of informatfon experiments or calculations and use the reportsdlite
science writers is [9]. A general IEEE style guided an Although not everything need be disclosed, a papest
Information for Authors are both available at contain new, useable, and fully described inforaratFor
http://www.ieee.org/web/publications/authors/trafigidex.html example, a specimen’s chemical composition needeaot

reported if the main purpose of a paper is to thice a
new measurement technique. Authors should expeot to
VII.  EDITORIAL POLICY challenged by reviewers if the results are not suggd by

Submission of a manuscript is not required foripiation adequate data and critical details.
in a conference. Do not submit a reworked versiba paper 5) Papers that describe ongoing work or announceatiest|
you have submitted or published elsewhere. Do miigh technical achievement, which are suitable for prgsn
“preliminary” data or results. The submitting authis at a professional conference, may not be apprepfat
responsible for obtaining agreement of all coawhramd any publication in @ RANSACTIONS Or JOURNAL.

consent required from sponsors before submittingaper.
IEEE TRANSACTIONS and ®URNALS strongly discourage
courtesy authorship. It is the obligation of thehaus to cite IX.  CONCLUSION

relevant prior work. A conclusion section is not required. Although adaasion
The Transactions and Journals Department doesutish  may review the main points of the paper, do noticate the

conference records or proceedings. THRANSACTIONS does abstract as the conclusion. A conclusion mightatate on the

publish papers related to conferences that haven beenportance of the work or suggest applications exténsions.

recommended for publication on the basis of pedeve As a

matter of convenience and service to the techeicalmunity, APPENDIX

these topical papers are collected and publishedénissue of

Appendixes, if needed, appear before the acknowiedg
the TRANSACTIONS.
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The preferred spelling of the word “acknowledgmeint”
American English is without an “e” after the “g.”sb the
singular heading even if you have many acknowledgsie
Avoid expressions such as “One of us (S.B.A.) wdikd to
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